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Introduction to Microsoft Word 2007 
Microsoft Word 2007 is a full feature word processing program that allows the user to design 
documents. The many formats available easily enable the user to produce professional reports, 
letters, essays and other documents incorporating the use of tables, charts, and graphics. Word 
2007 is part of Microsoft Office 2007, which includes other software applications. Microsoft 
Office 2007 offers Online Help for user assistance and questions related to the program. 

This guide is an introduction to Word 2007 and illustrates the basic functions the program offers. 
Start from the beginning for a general overview or choose the topics from the Contents page. 

Launching Word 2007 
There are six Open Access Labs (OAL’s) on campus.  A user can start Word 2007 from any of 
them. 

To start Word 2007 from a station in the Open Access Labs: 
1. Click the Start button  at the bottom left corner of the screen. 
2. Select the All Programs option. 
3. Select the Microsoft Office folder. 
4. Click the Microsoft Office Word 2007 icon. 

Working with the Word 2007 User Interface 
Word 2007 includes many enhancements to make working with the document easier, and to 
make the document more professional looking. The redesigned user interface includes the 
components illustrated in Figure 1. Refer to Table 1, for a brief description of each item. 

Table 1 - Word User Interface Components 
Item Description 
Title Bar Contains the title of the document and the application 
Office button Grouping of commands to save, open, print, and perform other 

commands common to all Office applications 
Quick Access 
Toolbar 

Collection of buttons to quickly access regularly used 
features of the application 

Ribbon Contains many features formerly found in menu structures 
Tabs Individual collections (groups) of commands within the Ribbon 
Insertion 
Point 

A flashing line on the screen that indicates where text will 
be entered into a document 

Scroll Bars Move through the document, up or down, left or right 
View Options Word 2003 provides several different ways to view a document 
Dialog 
Launcher 

A control for accessing more features contained within a group 
on the Ribbon 

Page Indicator Indicates the active page in the document 
Magnification 
Control 

Controls the magnification of the document 

Word Count Continuous display of the number of words in the document 
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In addition to the items described in Table 1, the user interface also contains a set of tabs called 
contextual tabs. Contextual tabs only appear above the tabs in the Ribbon when specific objects 
such as tables and pictures are selected. These tabs contain groups of commands that are relevant 
only to those specific objects. Contextual tabs are colored differently from the normal tabs on the 
Ribbon to alert the user that additional commands are available for the object selected. 

 
Figure 1 - Word 2007 Interface 

USING THE OFFICE BUTTON 
Word provides a collection of commands common to all Office applications that are grouped 
under the Office Button. The Office Button replaces the File menu that was found in previous 
versions of Microsoft Office. Clicking the Office Button (see Figure 2) will open a dialog box 
displaying the commands available (see Figure 3). In addition, Word can be customized by 
clicking the  button at the bottom of the dialog and selecting the options available.  
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Figure 2 - The Office Button 

 
Figure 3 - Commands within the Office Button Group

USING THE QUICK ACCESS TOOLBAR 
The Quick Access Toolbar is located above the Ribbon and contains common, frequently used 
commands. The commands available from the Quick Access Toolbar are always visible, which 
eliminates searching through the Ribbon or tabs (see Figure 1).  

MINIMIZING AND MAXIMIZING THE RIBBON 
Users can minimize the Ribbon, which will allow more of the document to be visible in the 
active window. When minimized, only the tabs will be visible. All of the commands within the 
groups of each tab on the Ribbon will still be available. 

To minimize the Ribbon: 
1. Click the Customize Quick Access Toolbar drop-down arrow . The Customize Quick 

Access Toolbar menu will open (see Figure 4). 
2. Select the  menu item. The Ribbon will be concealed.  

 
Figure 4 - Customize Quick Access Toolbar Menu 
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To use commands on the Ribbon while minimized: 
1. Click the tab where the command is located. The Ribbon will re-appear. 
2. Click the tab again and the Ribbon will be concealed. 

To maximize the Ribbon: 
1. Click the Customize Quick Access Toolbar drop-down arrow . The Customize Quick 

Access Toolbar menu will open (see Figure 4). 
2. Click the  menu item. The Ribbon will reappear.  

USING DIALOG BOX LAUNCHERS 
Dialog Box Launchers  are a new feature in Word 2007. These buttons appear in most (but 
not all) of the command groups on the Ribbon in each tab. If a group has a Dialog Box 
Launcher it will be located in the lower right corner of the group. Clicking a Dialog Box 
Launcher opens a specific dialog box that is relevant to the group. 

Creating, Saving, and Closing Documents 
Whenever the Word application is launched from the  menu, a new document is opened 
automatically. Users can also create a new document while an existing document is open. Once a 
document is opened or created, text can be entered at the blinking insertion point (see Figure 1) 
using the keyboard. The insertion point can be moved by pressing the [Enter] key. When 
entering text into a document, it is not necessary to press the [Enter] key at the end of each line 
because Word will automatically move the insertion point to the beginning of the next line. The 
[Enter] key must be pressed when beginning a new paragraph. 

To create a new document while an existing document is open: 
1. Click the Office Button (see Figure 2) then click the New  button in the available 

options. The New Document dialog box opens (see Figure 5). 
2. Click the  option in the Templates section of the dialog box. 
3. Select the  option in the Blank and Recent section of the dialog box. 
4. Click the  button. A new blank document will open in a Microsoft Word window 

independent of the existing document and the dialog box will close. 
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To save a new document for the first time: 
1. Click the Save button  on the Quick Access Toolbar. The Save As dialog box opens 

(see Figure 6). 
2. Enter a name for the document in the  text box. 

Figure 6 - Save As Dialog Box 

NOTE: By default, documents are saved in the My Documents folder on the main drive of the 
computer. If the user wants to save the document in a different folder or drive, click the  
drop-down arrow and select a different location. 

3. Click the  button to save the file. The dialog box will close. 

NOTE: By default, documents are saved with a file extension of .docx. This extension makes the 
document compatible only with Word 2007. If this file extension is used, the document will not open 
in previous versions of Word (97, XP, or 2003). If the user wants the document to be compatible with 
previous versions of Word then the Save As option should be used. 

NOTE: After a document has been saved for the first time, clicking the Save button  on the Quick 
Access Toolbar will save any changes without the Save As dialog box opening. 

USING SAVE AS 
The Save As option allows users to save a new or existing document in a different format other 
than the default Word 2007 format. This can eliminate document incompatibility with users who 
do not use Word 2007. 

To use the Save As option: 
1. Click the Office Button to display the commands within the Office Button group. 
2. Hover the mouse over the Save As button to display the options available (see Figure 7). 
3. If compatibility with previous versions of Word is desired, select the 

 option. The Save As dialog box will open with the Word 97-2003 
file format automatically selected. 
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4. If a different format is desired (such as a template or web page format) then click the 
 drop-down arrow and select the appropriate format. 

5. Enter a name for the file in the File name: textbox. 
6. Click the  button to save the document in a different format. 

Figure 7 - Save As Options 

CLOSING A DOCUMENT/EXITING WORD 
If a document has been saved, a user can close the document (and the Word application) by 
either clicking the Close button  in the upper right corner of the Microsoft Word window or 
by clicking the Office Button and then clicking the Close button at the bottom of the list of 
options (see Figure 7). Clicking the  button at the bottom of the list of options or the 
Close  button in the right corner of the title bar will close the Word application. 

NOTE: If unsaved changes have been made to the document, the user will be prompted to save the 
changes before the document closes and/or the application closes. If changes are not saved before closing 
the document or exiting Word, then the changes will be lost. 

Opening an Existing Document 
After creating and saving a document, the file resides on a disk. To view or edit an existing 
document, it must first be opened from the disk. 

To open an existing document: 
1. Click the Office Button. 
2. Click the Open button in the list of available options (see Figure 7). The Open dialog box 

appears (see Figure 8). 

NOTE: If the desired document is not in the default folder, click the  drop-down arrow and 
navigate to the appropriate folder and/or drive. 
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3. Click on the document name and, if necessary, click the  button. 

Figure 8 – Open Dialog Box 

Editing a Document 
Editing a document can consist of the addition or removal of characters. To edit a document, the 
text to be edited must be selected. Text can be selected using the dragging and highlighting 
method with the mouse. 

SELECTING TEXT 
Selecting text will be an important step in cutting, copying, pasting, deleting, and editing within 
a document. Table 2 describes different options for how to select text. 

Table 2 - Options for Selecting Text 
Action Descriptions
Selecting a word Double-click the word 
Selecting a 
sentence 

Hold down the [Ctrl] key on the keyboard then click 
anywhere in the sentence to be selected 

Selecting a 
paragraph 

Move the pointer to the left of the paragraph until it 
changes to a right-pointing arrow, and then double-click (a 
single-click will select the entire line). 

Selecting any 
amount of text 

Place the mouse in front of the text to select (it turns 
into an I-beam shape) then click and drag the mouse over 
the text 

Selecting the 
entire document 

Either move the pointer to the left of any document text 
until it changes to a right-pointing arrow, and then 
triple-click, or simply press the [Ctrl+A] key combination 
on the keyboard 

CUT, COPY, AND PASTE 
When editing a document, it may be necessary to move or copy text, either within the same 
document or between documents.  The text that is cut or copied will be placed onto the 
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Clipboard (a special area in the application from which material that has been cut or copied can 
be retrieved). 

Cut 
The Cut feature removes the selected text from the document, and stores it on the Clipboard. 

To cut text: 
1. Select the text to cut. 
2. Select the Home tab on the Ribbon. 
3. Click the Cut button  in the Clipboard group. The text is cut from its original 

location and stored on the Clipboard. 

Copy 
The Copy feature is similar to the Cut feature except that the Copy feature does not remove the 
text from its original location.  It creates a copy of the selected text and stores in on the 
Clipboard. 

To copy text: 
1. Select the text to copy. 
2. Click the Copy button  in the Clipboard group. The original text remains the 

same, and the copied text is stored on the Clipboard. 

Paste 
The Paste feature inserts the contents of the clipboard at an insertion point or over a selected 
area. 

To paste the last item cut or copied: 
1. Select the location to paste the text. 
2. Click the Paste button  in the Clipboard group. 

NOTE: The Cut, Copy, and Paste commands can also be 
executed by right-clicking the selected text with the mouse. A 
shortcut menu will appear containing these commands (see 
Figure 9). 

 
Figure 9 – Right-Click Shortcut 

Menu 

ACCESSING THE CLIPBOARD 
The Clipboard is where any cut or copied items are stored. To access the Clipboard, the 
Clipboard Task Pane (see Figure 10) must be opened by selecting the Home tab on the Ribbon 
and then clicking the Clipboard Dialog Box Launcher  in the Clipboard group. 

Deleting Clipboard Items 
When items on the Clipboard are no longer needed, they can be deleted from the Clipboard 
either individually or by clicking the  button. 

To delete items from the Clipboard individually: 
1. Place the cursor over the item to delete in the Clipboard Task Pane. A box around the 

item and a down-pointing arrow will appear to the right (see Figure 11). 
2. Click the drop down arrow . 
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3. Select the Delete option. 

 
Figure 10 – Clipboard Task Pane 

 
Figure 11 – Deleting Clipboard Items 

REMOVING TEXT 
There may be times when it is necessary to delete text. Once the text has been selected, it can be 
deleted with a single keystroke. Either the [Backspace] or the [Delete] keys on the keyboard can 
be used to remove one character at a time.  The [Backspace] key removes the character 
immediately to the left of the cursor and [Delete] key removes the character immediately to the 
right of the cursor. Additionally, the [Delete] key can also be used to delete a whole word, 
sentence, paragraph, or block of text at once after the text has been highlighted. 

DRAG AND DROP EDITING 
Word has a drag and drop editing feature that allows the user to move or copy text without first 
placing it on the Clipboard. 

To move text using drag and drop editing: 
1. Highlight the text to be moved. 
2. Click and hold the left mouse button over the highlighted text. 
3. Drag the mouse cursor to the new location and release the mouse button. 

To copy text using drag and drop editing: 
1. Highlight the text to be moved. 
2. Press and hold the [Ctrl] key. 
3. Click and hold the left mouse button over the highlighted text. 
4. Drag the mouse cursor to the new location and release the mouse button. 

Formatting a Document 
Formatting the characters in a document can enhance the appearance of the document and 
provide a more professional appearance to the entire document. 

LIVE PREVIEW 
Live Preview is a new feature in Word 2007. In the case of character formatting, Live Preview 
applies to the Font typeface, Font size, and Font color. Live Preview allows the user to visualize 
how a different typeface, size, or color will appear within the document. Live Preview 
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temporarily displays any changes to a selected object or selected text in the document without 
actually changing it. 

THE MINI TOOLBAR 
Another new feature in Word 2007 is the Mini Toolbar. The Mini Toolbar contains frequently 
used formatting commands and appears in a semi-transparent mode whenever text is selected for 
formatting. Moving the mouse over the toolbar activates it and makes the options available for 
use (see Figure 12). Most of the formatting options on the Mini Toolbar are discussed in the 
following sections. 

CHARACTER FORMATTING 
Character formatting enhances the appearance of text, and includes font typeface, font size, font 
style, and font color. Character formatting is applied using the features on the Home tab of the 
Ribbon in the Font group (see Figure 13). 

 
Figure 12 - The Mini Toolbar 

 
Figure 13 – Font Group 

Changing Font Typeface 
A font typeface is defined as a group of characters sharing similar type attributes. The default 
font typeface for new documents in Word 2007 is Calibri. 

To change the font typeface for selected text: 
1. Select the text to change. 
2. Click the Font Typeface drop-down arrow  in the Font group. A list of available fonts 

will appear. 
3. Select the desired font name to change the font typeface. 

Changing Font Size 
Font size refers to the height of printed text on a page and is measured in units called points. 
There are 72 points in one inch. The higher the number entered for the font size, the larger the 
text will be. The default font size for new documents in Word is 11 points. 

To change the font size for selected text: 
1.  Select the text to change. 
2. Select the Home tab on the Ribbon. 
3. Click the Font Size drop-down arrow  in the Font group. A list of available font sizes 

will appear. 

NOTE: Font sizes are not listed in increments of one point. If a desired font size is not listed in the 
Font Size drop-down list, click the number instead of the drop-down arrow, manually enter the 
desired font size and press the [Enter] key to apply the new font size. 
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4. Select the desired font size. 

Changing Font Style 
Font style refers to font type enhancement. See Table 3 for examples of the available font styles.  

Table 3 – Font Styles 
Button Font Style Example

 
Bold  Example of Bold text 

 Italic  Example of Italicized text 

 
Underline  Example of Underlined text 

 Strikethrough Example of Strikethrough text 

 
Subscript Example of Subscripted text 

 
Superscript Example of Superscripted text 

 Change Case Changes the case of the selected text 

The Underline and Change Case font styles have several options available that can be accessed 
by clicking the drop-down arrow  associated with each style (see Figure 14 and Figure 15). 

To change the font style for selected text: 
1. Select the text to change. 
2. Click the desired Font style button in the Font group. 

NOTE: It is possible to apply more than one font style to text. 

 
Figure 14 - Underlining Styles 

 
Figure 15 - Change Case Styles 

CHANGING FONT COLOR 
Two aspects of font color can be styled. The background color of the text (also known as the 
Text Highlight Color) can be changed from the default color of white and the color of the font 
itself can be changed from the default color of black. 

To change the Text Highlight Color for selected text: 
1. Select the text to change. 
2. Click the Text Highlight Color drop-down arrow on the Text Highlight Color button 

 in the Font group. The available highlight colors will appear (see Figure 16). 
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3. Select the desired color. 

To change the font color for selected text: 
1. Select the text to change. 
2. Click the Font Color drop-down arrow on the Font Color button  in the Font group. 

The available font colors will appear (see Figure 17). 
3. Select the desired color. 

NOTE:  Once a color has been selected for either of the styles, it will remain selected until changed. 
To apply the same color to different text in the document, highlight the text and click the Font Color 
button or the Text Highlight Color button. 

 
Figure 16 - Text Highlight Colors 

 
Figure 17 - Font Colors 

PARAGRAPH FORMATTING 
There may be times when it is necessary to make paragraphs in a document stand out from other 
text. It is possible to change the line spacing, use indentations, or set tab stops so the text can 
appear in fixed locations across the page. Paragraph formatting can be applied by using the 
Paragraph dialog box, the Horizontal Ruler, or shortcut buttons and keystrokes, depending on 
which type of paragraph formatting will be applied. 

Paragraph Alignment 
Paragraph alignment refers to the horizontal alignment of a paragraph. See Table 4 for 
descriptions of the different paragraph alignments that can be applied.  Paragraph alignments can 
be applied either by using the alignment buttons on the Formatting toolbar or by using the 
Paragraph dialog box. 

Table 4 – Paragraph Alignment Options 
Button Description 

 Align Left  

Left alignment aligns text to the left margin and produces a 
ragged (uneven) right margin.  Align Left is the default 
setting. 

 Center  
Center alignment centers text to the middle of the page 

(between the left and the right margins). 

 Align Right  
Right alignment aligns text to the right margin and produces 

a ragged (uneven) left margin.

 Justify  
Justified alignment aligns text to the both left and right 
margins so that neither margin is ragged. 

To apply paragraph alignment using the shortcut buttons: 
1. Place the cursor within the paragraph to apply paragraph alignment. 
2. Click the desired paragraph alignment button in the Font group. 
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To apply paragraph alignment using the 
Paragraph dialog box: 

1. Place the cursor within the 
paragraph to apply a new 
paragraph alignment. 

2. Click the Paragraph Dialog Box 
Launcher  in the Paragraph 
group. The Paragraph dialog box 
opens (see Figure 18). 

3. Select the Indents and Spacing tab 
if it is not selected. 

4. Click the Alignment: drop-down 
arrow in the General section 

5. Select the desired paragraph 
alignment option. 

6. Click the OK button. 

 
Figure 18 – Paragraph Dialog Box 

Line Spacing 
Line spacing refers to the distance between every line in a paragraph. Line spacing can be 
adjusted in the Paragraph dialog box, or by selecting the Home tab on the Ribbon and using the 
Line Spacing drop-down list  in the Paragraph. Spacing options in the list include 1.0, 1.15, 
1.5, 2.0, 2.5, and 3.0. 

NOTE: If the line spacing option desired is not in the Line Spacing drop-down list, select 
 from the list to open the Paragraph dialog box, or open the dialog box using the 

steps described below 

To apply line spacing using the Paragraph dialog box: 
1. Place the insertion point within the paragraph where the line spacing will be applied. 
2. Click the Paragraph Dialog Box Launcher  in the Paragraph group. The Paragraph 

dialog box opens (see Figure 18). 
3. Select the Indents and Spacing tab, if it is not selected. 
4. Click the Line spacing: drop-down arrow in the Spacing section. 
5. Click the desired selection (see Table 5). 
6. If necessary, enter a value in the At: spin box 
7. Click the OK button. 
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Table 5 - Line Spacing Options 
Option Description 
Single Accommodates the largest font in the line with a small amount of 

extra space 
1.5 Lines One-and-one-half times that of single line spacing 
Double Twice that of single line spacing 
At Least Specifies the minimum line spacing to fit the largest font on the 

line (specify point size in the At: spin box) 
Exactly Specifies fixed line spacing that Word does not adjust (specify 

point size in the At: spin box) 
Multiple Sets line spacing that is increased or decreased from single line 

spacing by a percentage specified in the At: spin box (a value of 
1.2 would increase line spacing by 20% of single spacing) 

To apply line spacing using shortcut keystrokes: 
1. Place the insertion point within the paragraph where the line spacing will be applied. 
2. Press the keystroke combination for the desired line spacing (see Table 6). 

Table 6 – Keystroke Combinations for Setting the Line Spacing 
Keystroke Line Spacing Applied
[Ctrl+1] Single Line Spacing
[Ctrl+5] 1½ Line Spacing
[Ctrl+2]  Double Line Spacing

Indentations 
An indentation is the space between the text and the left and/or right margins. Indentations can 
be applied by using the indentation markers on the Horizontal Ruler. See  

Table 7 for descriptions of different types of indentations available.  

Table 7 – Indentation Types 
Indentation Description

Left and Right Indent Indents the entire selected paragraph from the 
Left/Right margin 

First Line Indent Indents only the first line of the selected paragraph 
from the Left margin 

Hanging Indent Indents all lines of a paragraph other than the first 
line from the left margin 

The Horizontal Ruler (see Figure 19) should display automatically when Word 2007 is 
launched. If not, display it by selecting the View tab on the Ribbon and checking the  check 
box in the Show/Hide group or by clicking the View Ruler button  located above the Vertical 
scroll bar on the right side of the Word interface. 

 
Figure 19 – Horizontal Ruler: Indentation and Tab Stop Markers 

 
Figure 20 - 

Hanging Indent 

To apply indentations using the Horizontal Ruler, simply drag the indentation marker(s) on the 
Horizontal Ruler to the point in the paragraph where the indent will begin (see Figure 19 and 
Figure 20). 
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Setting Tab Stops 
At times it is necessary to have text appear at fixed locations across the page. Tab stops can be 
used to space text in a paragraph. Each paragraph can have a different combination of tab stops. 
Tab stops can be set by using the Tab Stop button on the Horizontal Ruler (see Figure 19). 
Table 8 describes the different types of tab stops available. 

Table 8 – Tab Stops 
 Tab Descriptions

 Left–Aligned Tab    Text and numbers are aligned left to the tab stop 

 Center Tab          Text and numbers center under a center tab stop 

 Right–Aligned Tab   Text and numbers align right to the tab stop 

 Decimal Tab         Text and numbers align to the tab stop at the first 
decimal point 

 Bar Tab             Creates a vertical line at the tab stop each time a new 
line is created 

To set tab stops using the Horizontal Ruler: 
1. Place the insertion point within the paragraph where the tab stops will be set. 
2. Click the Tab Stop button at the far left of the Horizontal Ruler until it changes to the 

type of tab desired (see Table 8). 
3. Click the Horizontal Ruler where to set a tab stop. A tab stop marker will appear. 

NOTE: The text insertion point can be moved to the tab stop by pressing the [Tab] key at the 
beginning of the line. 

CHANGING STYLES 
Styles are predefined combinations of character and paragraph formatting. Styles can be used to 
identify headings at the beginning of a section of a document, or applied to the text within a 
paragraph. By using styles, it is easier to apply different character and formatting attributes 
simultaneously instead of having to apply them individually. When creating a new document 
approximately 16 different styles are available (see Figure 21). Whenever a new formatting style 
is applied to the text of the document, a new style is created for that document so it can be used 
to apply the same formatting attributes to another section later on with a single click. 

 
Figure 21 – Default Styles Available in a New Document 

To apply a heading style: 
1. Select the text where the style will be applied. 
2. Click the More drop-down arrow  in the Styles group. The list of available styles will 

expand similar to Figure 21. 
3. Select the desired heading style. The style will be applied immediately to the selected 

text. 
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NUMBERS AND BULLETS 
When presenting a list of items, it is possible to number or bullet each item to distinguish one 
from the other.  A bulleted list is used for basic item lists while a numbered list is often used 
when the order is important (i.e. instructions). It is also possible to develop multilevel lists where 
each line in the list is indented 

To create a bulleted list: 
1. Select the text where bullets will be applied. 
2. Click the Bullets button  in the Paragraph group. 

To create a numbered list: 
1. Select the text to add numbers to. 
2. Click the Numbering button  in the Paragraph group. 

To create a multilevel list: 
1. Select the text where bullets will be applied. 

2. Click the Multilevel List button  in the Paragraph group. 

NOTE: To select list style different than the default styles in the buttons, click the drop-down arrow 
 on the right side of each button. The different options for each type of list will be displayed (see 

Figure 22, Figure 23, and Figure 24). 

 
Figure 22 - Bulleted List Options Figure 23 - Numbered List 

Options 
Figure 24 - Multilevel List Options 

To undo bulleted, numbered, or multilevel lists: 
1. Select the text. 
2. Click the appropriate button in the Paragraph group. 

SETTING BREAKS 
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Documents can also be formatted with the inclusion of breaks. There are four types of breaks: 
Page Break, Column Break, Section Break, and Text Wrapping Break. Page Break is an 



efficient way to insert text onto a new page without using the [Enter] key multiple times. In a 
page with multiple columns, a Column Break is used to wrap text from the bottom of one 
column to the top of the next. Text Wrapping Breaks are applicable only to web pages. Section 
Breaks allow a page to be broken into sections (parts) that are independent of each other. 
Sections breaks can have their own formatting, page layout, columns, headers or footers. There 
are four types of Section Breaks that can be used in a document: the Next Page break, the 
Continuous break, and the Even or Odd Page break. A Next Page break is similar to a Page 
Break in that it ends the current page and begins the new section on the following page. A 
Continuous break inserts the new section on the current page and continues the section until a 
new section is designated. An Even or Odd Page break inserts a break and begins the new 
section on the next even or odd page, depending on the break chosen. 

 
Figure 25 - Page and Section Breaks 

To insert a break into a document: 
1. In the document, place the insertion 

point where the breaks will be located. 
2. Select the Page Layout tab on the 

Ribbon. 
3. Click the  drop-down list in 

the Page Setup group to display the 
available breaks (see Figure 25). 

4. Select the appropriate break. 

 
Figure 26 - Page Break Button 

NOTE: A Page Break can also be set by selecting Insert tab on the Ribbon and clicking the Page Break 
drop-down list in the Pages group (see Figure 26). 

Changing Margins 
Margins control the space between the top, bottom, left, and right edges of the paper and the text. 
The dark section of the Horizontal Ruler represents the margin, and the white section represents 
the width of the work area of the document (see Figure 27). 

Figure 27 – Margins 

To change the margins of a document: 
1. Select the Page Layout tab on the Ribbon. 
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2. Click the Margins drop-down list in the Page Setup group (see Figure 28) to display the 
margins options available (see Figure 29). 

NOTE: If the desired margins are not available, custom margins can be applied by using the Page 
Setup dialog box (see Figure 30). 

To set custom margins 
1. Click the  option in the Pre-Set Margins list (see previous instructions and 

Figure 29) OR  
1. Click the Page Setup Dialog Box Launcher  in the Page Setup group. The Page 

Setup dialog box opens (see Figure 30). 
3. Select the Margins tab if it is not already selected. 
4. Enter the desired margin widths in the Top:, Bottom:, Left:, and Right: spin boxes under 

the Margins section. 
5. Click the OK button. 

 
Figure 28 - Margins Drop-Down List 

 
Figure 29 - Pre-Set Margins Options 

 
Figure 30 - Page Setup Dialog Box Margins Tab 

Viewing the Document 
Word provides several different ways to view a document. The document can be magnified to 
make it easier to read, or the magnification can be reduced to view more of the document, in 
order for the user to get a better view. 

SWITCHING DOCUMENT VIEWS 
There are five different view styles to choose from. See Table 9 for the descriptions of the 
different view options.  By default, new documents open in Print Layout view. Document views 
can be changed by clicking the appropriate button in the Document Views group in the View tab 
or the appropriate button on the bottom right of the Word User Interface (see Figure 1). 
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Table 9 - Table Document View Options 
View Option Description
Print Layout View the document as it will appear when printed 
Full Screen Reading Maximizes the space used in the window 
Web Layout View the document as it would look as a Web page 

Outline View the document as an outline and show the outlining 
tools 

Draft Allows for quick editing of text; no headers or footers 
are visible 

MAGNIFYING A DOCUMENT 
Magnifying documents makes them easier to read. The magnification level can be set to a 
percentage of the actual size, or to view the entire width of the page. Changing the magnification 
does not change the document on paper; it only changes how the document appears on the 
screen. 

To magnify a document: 
1. Select the View tab on the Ribbon. 
2. Click the Zoom button in the Zoom group.  The 

Zoom dialog box will open (see Figure 31). 
3. Choose the desired magnification level in the 

Percent: spin-box or one of the preset levels by 
clicking an option button 

4. Click the OK button. 

NOTE: The magnification level can also be changed 
using the Zoom slider control located on the Status Bar 
(see Figure 1).  

Figure 31 -  Zoom Dialog Box 

Printing a Document 
Printing options in Word 2007 are accessed by clicking the Office Button and hovering the 
mouse over the Print button to display the options available (see Figure 32). Word prints the 
entire document using the formatting and margin settings as defined in previous sections. The 
options available in the Print menu of the Office Button include Print (which opens the Print 
dialog box and allow the user to change printer settings), Quick Print (which sends the entire 
document to the printer without opening the Print dialog box), and Print Preview (which allows 
the user to view the document in final form before printing). 
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Figure 32 - Print Options 

 
Figure 33 - Close Print Preview Button 

PREVIEWING A DOCUMENT 
Before printing, it is best to preview the document to see how the text appears on each page.  The 
Print Preview feature displays the pages as they will appear when printed. Using the Print 
Preview feature can avoid wasting time and paper by viewing the draft version of the document. 

To use Print Preview: 
1. Click the Office Button. 
2. Hover the mouse over the Print button to display the printing options (see Figure 32). 
3. Click the  option. 

NOTE: Print Preview opens with one page of the document sized to fit in the window. The 
document magnification can be changed by using the Zoom slider control as described in the 
Viewing the Document section of this handout. 

4. To exit Print Preview , select the Preview Tab on the Ribbon 
5. Click the Close Print Preview button in the Preview group (see Figure 33). 

PRINTING OPTIONS 
Printing options found in the Print dialog box (see Figure 34) include printing the current page, 
selected text, a range of pages, or the entire document. 
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Figure 34 - Print Dialog Box 

Printing the Current Page 
When printing a document, it is possible to print only the current page. This option is useful if 
there were changes made to only one page after printing the entire document. 

To print the current page: 
1. Make sure the insertion point is within the page to print. 
2. Click the Office Button. 
3. Click the Print option.  The Print dialog box will open (see Figure 34). 
4. Click the Current Page option button in the Page range section. 
5. Click the OK button. 

Printing Specific Pages 
If needed, Word can print specific pages within a document. The pages do not have to be 
consecutive or in any particular order. 

To print a selected page: 
1. Click the Office Button. 
2. Click the Print option.  The Print dialog box will open (see Figure 34). 
3. Click the Pages: option button in the Page Range section. 
4. Type in the page numbers to print, using commas to separate pages, or hyphens to print 

adjacent pages. For example, 1-12 (pages 1 through 12 will print), or 14, 19, 24 (only the 
individual pages 14, 19, and 24 will print). 

5. Click the OK button. 

Printing a Selection from the Document  
Printing only a selection is useful to save time and paper if only an excerpt of a document is 
required. 

To print only the selected text from the document: 
1. Highlight the portion of the document to print. 
2. Click the Office Button. 
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3. Click the Print option.  The Print dialog box will open (see Figure 34). 
4. Click the Selection option button in the Page Range section. 

NOTE: If there is no text in the document selected before opening the Print dialog box, the Selection 
option will not be available. 

5. Click the OK button. 

Printing Multiple Copies 
There are times when it is necessary to print multiple copies of a document. 

To print multiple copies: 
1. Click the Office Button. 
2. Click the Print option.  The Print dialog box will open (see ). 
3. Enter the number of copies to print in the Number of copies: box in the Copies section. 
4. Click the OK button. 

NOTE: To get sets of multiple copies, check the Collate check box  located under the 
 spin box. 

SELECTING A PRINTER 
If there is a shared network of printers, like the set up of the library and computer labs, it will be 
necessary to choose the appropriate printer. 

To select a printer: 
1. Click the Office Button. 
2. Click the Print option.  The Print dialog box will open (see ). 
3. Click the Name: drop-down arrow. 
4. Select the printer from the drop-down list. 
5. Click the OK button 

Using the Help Function 
Word 2007 has an extensive Help function to answer any questions the user may have regarding 
the commands and functions of Word. The Help function includes two components, the 
component that is built in to the Word application and the online component that is available if 
an active Internet connection is available. The Help function can be activated from the Word user 
interface by clicking the Microsoft Word Help button  located in the upper right corner of 
the interface. It can also be activated from any open dialog box by clicking the Help button  
which is located in the upper right corner of all dialog boxes. Clicking either of these buttons will 
open the Help dialog box (see Figure 35). When the dialog box opens, the user is presented with 
a list of general help topics in the Browse Word Help section (see Figure 35). Clicking on any of 
the links will take the user to more detailed information about that topic. If the topic is not 
present in the Browse Word Help section, the user can perform a search of the Help function. 

To search the Help function: 
1. Click inside the Search text box (see Figure 35). 
2. Type in a keyword or keywords related to the topic. 
3. Press the [Enter] key. Word will search the Help function and present the user with a list 

of topics that are most relevant to the search. 
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Figure 35 - Help Dialog Box 

 
Figure 36 - Office Online (not Activated) 

Figure 37 - Office Online (Activated) 

Online Help 
The Word Help function can also be used to connect to Office Online. By connecting to Office 
Online, the user can find templates, Clip Art, information about Microsoft Office products and 
more Help topics on the Internet. 

To activate Office Online: 
1. Click the  button in the lower right corner of the Help dialog box. 
2. Click the  option (see Figure 36). The status will change to 

.  

To deactivate Office Online: 
1. Click the  button in the lower right corner of the Help dialog 

box. 
2. Click the  option (see Figure 37). The status will change 

to . 

Introduction to Microsoft Word 2007 - 25 


	Launching Word 2007
	Working with the Word 2007 User Interface
	Using the Office Button
	Using the Quick Access Toolbar
	Minimizing and Maximizing the Ribbon
	Using Dialog Box Launchers

	Creating, Saving, and Closing Documents
	Using Save As
	Closing a Document/Exiting Word

	Opening an Existing Document
	Editing a Document
	Selecting Text
	Cut, Copy, and Paste
	Cut
	Copy
	Paste

	Accessing the Clipboard
	Deleting Clipboard Items

	Removing Text
	Drag and Drop Editing

	Formatting a Document
	Live Preview
	The Mini Toolbar
	Character Formatting
	Changing Font Typeface
	Changing Font Size
	Changing Font Style

	Changing Font Color
	Paragraph Formatting
	Paragraph Alignment
	Line Spacing
	Indentations
	Setting Tab Stops

	Changing Styles
	Numbers and Bullets
	Setting Breaks

	Changing Margins
	Viewing the Document
	Switching Document Views
	Magnifying a Document

	Printing a Document
	Previewing a Document
	Printing Options
	Printing the Current Page
	Printing Specific Pages
	Printing a Selection from the Document 
	Printing Multiple Copies

	Selecting a Printer

	Using the Help Function
	Online Help


